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Important notes:
•	The new AI Providers page requires all AI providers to be set up again for users with 

features such as Call Transcription, Voicemail transcription, and TTS configured. It is a 
breaking change so all of these should be reconfigured.

•	Stereo recording now requires the RAM Disk to be enabled

•	Live Call Transcription (which is implemented this release) requires Stereo Recording to 
be enabled

•	The archiving monitor system is changed, and recordings on the file system are 
restructured to follow the /year/month/day/hour format within the ‘monitor’ directory 
(it might take the system some time to restructure the existing recordings on first start 
after upgrade, so some CDR functionalities may not be available).

PBXware version 8.0 introduces important licensing updates. 

•	Event Publisher will be automatically enabled system-wide on all systems where Event 
Manager was previously enabled for any tenant.

•	AI features will be enabled on all v8 systems by default, with the option for system 
administrators to further enable or disable it per tenant using Groups.

•	Contact Center Lite is a licensed feature for Multi-Tenant and Business editions that 
will be charged after the trial period is completed.  
 
On the Contact Center edition, these features are available without additional charges.

•	The new CRM Module (crmconnector service) introduces a separate licensing model on 
a per-user (per-seat) model within each CRM integration.  
 
CRM licensing operates independently of the PBXware Editions & Modules configuration.  
Each tenant (Multi-Tenant edition) or system (Contact Center and Business editions) 
supports one custom CRM integration. CRM routing for a specific integration is enabled 
by default once at least one active license is assigned.  
 
A free trial period is available until May 1, 2027. During this period, the new CRM module 
is enabled by default on all v8 systems, with the option for system administrators to 
control its availability per tenant or system using Groups.
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We are happy to introduce PBXware version 8.0 - Our biggest update yet, which includes many 
new features and major improvements in order to provide the best possible experience to our 
customers. With this major update, we have added a few big features, such as an AI Voice 
Agent - AI Voice Connector being the service which enables it - which allows administrators 
to configure an AI Voice Agent as a specific DID destination to which calls can be directed to 
and answered by it. In addition, Live Transcription, Text to Speech, and Voicemail Transcription 
have been introduced under the new AI Hub, further expanding PBXware’s AI capabilities. 
Event Publisher has also been added, which is planned to replace the previously used Event 
Manager. Event Publisher is a lot more powerful, where each event sends specific data to a 
server that the consumer has configured for themselves. For easier use, configuration and 
billing, API Keys for AI features such as Live Transcription, Transcription, Voice Agents and 
TTS will now be managed per server/tenant, where all the data and information can be stored 
in one place. In this way, separate API Keys can be used for different tenants since billing is 
handled per API Key.

In addition to these major innovations, PBXware v8.0 introduces several other significant 
enhancements. A completely redesigned CRM Module is now available in gloCOM Web 
and the new gloCOM Desktop application, delivering improved and deeper integration with 
external CRM platforms. The new architecture supports multiple CRM integrations per tenant/
company and enables flexible data model management within customizable CRM widgets 
across all communication channels. Conversations are automatically logged in connected 
CRMs, enhancing accuracy, improving operational efficiency, and increasing productivity for 
sales and support teams. Advanced CRM Routing for voice introduces intelligent, data-driven 
call handling based on real CRM records, enabling dynamic routing decisions tailored to 
customer profiles. The new Unified Contacts module replaces the legacy Central Phonebook 
and introduces structured contact visibility levels (Global, Department, and Private), centralized 
management, smart CSV synchronization, and enhanced permission control. Furthermore, 
Contact Center Lite enhances monitoring capabilities by introducing Wallboard and ERG 
dashboards in gloCOM Web and Desktop, along with Scheduled Reports for both Enhanced 
Ring Group (ERG) and Extension statistics, including ERG callback support—providing 
improved visibility and reporting across editions.
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Features

Event Publisher
PBXware 8.0.0 introduces Event Publisher, designed to replace the previous Event Manager. 
This new feature gives its users more freedom by allowing them to integrate their own backend 
server and handle data generated by various events however they wish. With Event Publisher, 
we have access to real-time events, meaning that any change in the call flow will generate 
a new event with various details.

NOTE: This feature must be enabled on the license before it can be accessed; once enabled, 
it can be found on the Home tab.

A list of existing webhooks can be found under the Webhooks page, together with their 
names, descriptions, URLs, and enabled status. Users can edit or delete them accordingly, 
or use the search bar to search for any specific webhooks.

Clicking the ‘Add Webhook’ button opens a new screen that prompts the administrator to 
enter details for the webhook they want to configure.

Various webhook details can be configured in this screen, and there are a few sections. For 
more information on each section, please refer to the screenshot and detailed instructions 
below.  
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General

In this section, the administrator can enter the name and description of the webhook that 
they are configuring. Additionally, the webhook can be activated or deactivated by selecting 
an appropriate option under the ‘Active’ field. Please note that it is not active by default.

Request

In this section, a valid URL must be entered. It is a required field, and the URL must be valid for 
webhooks to work properly. Additionally, users can set headers, and those that are entered 
are hardcoded and will be sent as such to the entered URL.
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Auth

In this section, various Auth options can be selected; they must be configured correctly for 
the webhook server used. Current Auth options are as follows: ‘No Auth’, ‘Basic Auth’, ‘Bearer 
Token’, ‘OAuth Client Credentials’, and ‘OAuth Resource Owner Password Credentials’.

Events

This section allows a user to toggle the button to subscribe to all events or not. This also 
includes any additional events that may be added.

Event category: call

This section allows selecting different call events that will trigger the configured webhook. 
If any additional information is needed for an event, a user can click the information icon 
to open an iframe with documentation and other necessary information about the event. It 
explains when the webhook will be fired.

EXAMPLE: 
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The system administrator can also give permissions to user groups to enable or disable the 
usage of webhooks. Those users who belong to user groups that do not have the permission 
to access the Event Publisher will not be able to see it nor perform any other kind of actions 
(add, edit, or delete). The option can be enabled in Admin Settings -> Groups -> Group, within 
the ‘Other’ tab. For more information, please refer to the screenshot.  

Concurrent Archiving
With the PBXware 8.0.0 release, concurrent archiving of call recordings has been 
implemented, along with additional changes. Upon updating to this version of PBXware, 
folder granularity will be applied. For concurrent archiving to be implemented, the monitor 
directory structure had to be changed so that recordings are now granulated in the /year/
month/day/hour UTC format. Recordings that already exist on the system will be migrated.

Note: While the migration of recording files is in progress, some functionalities such as listening 
to call recordings, call transcriptions, and archiving/offloading will be skipped during this 
process. 

Concurrent archiving uses multiple workers to process call recordings as they are offloaded. 
Administrators can configure the number of workers they wish to use in the /remote_fs/conf.
ini file by adding max_workers = x to the [global] section, where x is the preferred number of 
workers. The default number of workers is 5.

To avoid offloading recordings that are still in progress, the active_rec_timeout option has 
been added to the global section of the archiving configuration file. This option specifies the 
number of minutes to wait after the recording file is last modified before offloading it. The 
default value is 5 minutes.

Important Note: With this update, archiving CLIRs will no longer be available. The option 
has been removed from the Resources dropdown.
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AI Hub
A new tab, AI Hub, is introduced in PBXware 8.0, allowing easy configuration and management 
of all of PBXware’s AI features. It includes the following features:

•	 AI Providers - where administrators can configure AI Providers, including credentials, 
required provider details, and scopes used by AI Hub features.

•	 AI Agent - where administrators can configure an AI Voice Agent to answer calls and 
guide callers through a conversation.

•	 Live transcription - a feature that allows admins to configure real-time ERG, Queue and 
Extension call transcriptions of the conversations.

•	 Call Transcriptions - Enables administrators to configure Call Recording Transcriptions.

•	 Text to speech - where administrators can use AI Providers to generate a sound file 
from a text.

•	 Voicemail Transcription - Transcribes voicemails using some of the available AI 
Providers.

Through this AI Hub, users can easily navigate through all of the AI features, all of which 
will be described in more detail individually.

Note: The AI Hub features are enabled in the license by default, with the option for 
administrators to further enable or disable these features by tenant (on MT systems).
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AI Providers
With this new release, the way AI Providers are managed has changed. In the earlier versions, 
each AI feature had to configure its AI Provider individually. With version 8.0, AI Providers can 
be configured per tenant, and admins can additionally select what the certain provider will 
be used for.

A list of created providers will be visible here, where they can be edited or deleted. The 
Providers can also be filtered by:

•	 Scope: All, Text To Speech, Speech To Text, Speech to Speech and Real Time Speech 
To Text

•	 Provider: All, OpenAI, Google Speech, IBM, Deepgram, AWS Transcribe, xAI, Hosted 
Whisper, Eleven Labs

•	 It is also possible to use the Search bar to search for any specific providers.

IBM Watson Voicemail Transcription — Deprecated

IBM Watson voicemail transcription has been deprecated as of PBXware 8.0.0. The functionality 
remains available in this release but will be removed in a future version. Users relying on IBM 
Watson for voicemail transcription are encouraged to migrate to an alternative provider.

Additionally on this page you can add new providers by clicking the ‘Add AI Provider’ button, 
which will open a new screen and prompt the administrator to enter necessary details.
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You must enter a name for the provider, and select one AI Provider from the dropdown. Upon 
selecting one of the providers, new fields will appear, all depending on the selected provider. 
The Provider needs to be configured properly in order for AI features to work.

One of the fields that will appear after selecting a provider will be Scope, where you can 
manage what the chosen provider will be used for. Available options depend on the provider, 
so some scopes will not be available for all of them.

AI Voice Agent
This new feature allows for inbound calls to be answered automatically by an AI Voice Agent, 
with an AI driven experience, in a consistent tone that is configured by the administrator, and 
can guide callers through the conversation, transfer the call and also end calls when the 
conversation is completed.

In the AI Agent page, a list of created agents can be viewed and managed. They can be 
edited and deleted.

Clicking the ‘Add Voice Agent’ button will open up a new screen where the agent can be 
configured. Please note that prior to this step you should already have some AI Provider 
configured. It is required for setting up Voice Agents. 
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When first configuring the AI Agent, the Agent name should be entered and the AI provider 
needs to be selected, since they are required fields for creating one., whereas Agent slug 
is an optional field. After the AI provider has been selected, the AI Voice Agent window will 
expand, offering many options for configuring the AI Agent.

Currently supported providers for AI Voice Agents are OpenAI, xAI, and ElevenLabs. The 
available models depend on the selected provider:

•	 OpenAI 
Voice models: gpt-realtime, gpt-realtime-mini                                              
Transcription models (optional): whisper-1, gpt-4o-mini-transcribe, gpt-4o-transcribe

•	 xAI 
Model: grok

•	 ElevenLabs  
Models: Multiple voice models are available (22 total) and are configured exclusively 
on the ElevenLabs platform. In PBXware, the administrator copies the Agent/Voice ID 
from ElevenLabs and pastes it into the provider configuration.

Here, administrators can completely customize the AIVoice Agent, including its behavior. 

Model and Transcription model (if transcription is going to be used as well) can be selected. 
Administrators can also configure and customize the behavior and mannerisms of the AI 
Agent by populating the Introduction field, and the Prompt box. Within the Prompt text box, 
more specific settings regarding the AI Voice Agent can be set, such as its objective when 
answering the calls, the tone, context, personality, etc, as shown in the example. To further 
modify the AI Agent, a different voice can be selected for it.

The Prompt field now also supports template variables, allowing dynamic call-related 
information to be inserted directly into the prompt and used during the conversation flow, 
including tool usage and interactions between the agent and caller. Currently supported 
variables include: 

%CALLER_ID%

%CURRENT_TIME%

%CURRENT_DATE%

%CURRENT_DATE_TIME%

This allows administrators to build more context-aware prompts and create more flexible 
agent behavior based on real-time call information.
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Most importantly, the prompt section is used to configure and define the transferring logic for 
the Voice Agent. Here, it is also possible to configure a prompt which will be used to transfer 
calls between agents. This is an especially useful feature because all the external knowledge 
of one AI Agent about the caller is being transferred to the other agent.

Aside from configuring the personality of the AI Agent, further configuration needs to be 
completed in order for it to work properly. Dial number of the AI Agent is a required field and 
must be populated. It is the number which will be dialed to reach it locally, since it also acts 
as an extension. Later on, a DID has to be configured to point to the AI Agent directly so it 
can be reachable, otherwise it will not be possible to reach it from outside the PBXware.

Some extra options include toggling the ‘Limiting call duration (min)’ option and entering the 
maximum amount of minutes the call can last if it is enabled; and call Configurable fallback 
behavior can be set in case service is not responding within a defined time interval,  allowing 
the call to be transferred to another number or automatically ended.The Fallback timeout is 
the amount of seconds the call will be transferred or ended, depending on fallback behavior, 
in case connection is lost.

Note: it is very important that you set up the AI Agent prompt carefully and precisely so 
that the agent functions as well as possible, and transfers calls properly. Additionally, the 
configuration and functionalities depend on the selected AI Provider, and the example 
described is based on OpenAI.
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MCP Server

An MCP (Model Context Protocol) can be configured in the AI Agent settings. This connects 
your PBXware AI Agent with external services. It helps the AI Agent provide reliable data to 
the callers when requested. It is not mandatory to set up an MCP Server, but it greatly helps 
improve the AI Voice Agent experience, as it allows it to use any external information it may 
need, it provides a single place where tools are maintained and managed

Multiple MCP Servers can be added per AI Agent. While adding an MCP Server, you need 
to enter a Name and a URL (MCP Endpoint) provided by a tool hosting service. These are 
required fields.

Under the Type dropdown, currently available connection options are SSE and Streamable 
HTTP.

If necessary, headers can also be added in the Headers section by populating the Header 
Name and Header Value fields.

When all of the required fields are populated, clicking the ‘Save MCP server’ will add it to the 
list of servers in the section below.

The MCP Servers section displays a list of all the MCP endpoints that are connected to the 
AI Agent, where they can be edited and deleted.

In order to create the MCP server, there is a wide range of open source or commercial 
solutions that are designed to help partners easily build and orchestrate AI actions.
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CDR - AI Voice Agent Call Log
Calls that were handled by an AI Voice Agent are now clearly marked on the CDR page with 
a purple AI badge next to the agent/extension number. Clicking the agent number opens 
a right-side panel called AI Voice Agent Call Log, providing quick access to the full call 
context and agent activity for that specific call.

The AI Voice Agent Call Log side panel contains three tabs:

•	 Transcript – Displays the full conversation between the caller and the selected AI agent, 
with an option to download the transcript.

•	 Events – Shows a chronological list of agent events captured during the call (for example, 
tool/function calls, including agent-to-agent transfer events), helping with troubleshooting 
and validation.

•	 Info – Provides a summarized view of the selected agent’s call details (such as whether 
the call was transferred, which agent received the transfer, and the AI provider used).

If the call involved multiple AI agents (for example, when transferring from one AI agent 
to another), the panel includes an agent dropdown at the top. This dropdown lists all AI 
agents that participated in the call, allowing you to switch between them and review the 
corresponding Transcript, Events, and Info for each agent.
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Call Transcription
The Call Recording Transcription feature that was implemented earlier has been moved to 
the AI Hub tab along with all the other AI features. It functions just as before, but the setup is 
going to be much easier. The administrator needs to select the model and the AI Provider (the 
AI Provider has to be added to the AI Providers page) and save the configuration. Supported 
providers for Call Recording Transcription are:

•	 Hosted Whisper 
Models: base, base-en, small, small-en, medium, medium.en, large-v1, large-v2, 
large-v3, tiny, tiny.en

•	 OpenAI 
Model: whisper-1

Optionally they can add a prompt in the Prompt text box.

WIth this new release, it is now also possible to allow transcriptions in OSC. Users which 
can access OSC, with ‘Allow Transcription in OSC’ can view transcriptions from their call 
recordings, or request a transcription to be generated.

Important Note: Since this has been moved to the AI Hub, it is a breaking change. Users 
that previously had Call Recording Transcriptions will have to re-configure it. Additionally, 
‘Use RAM disk’ option, which can be found in server settings, must be set to ‘Yes’ in order 
for Call Recording Transcriptions to function.
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Live Transcription
Live Transcription enables real-time speech-to-text for calls routed through an ERG or Queue. 
When enabled, PBXware captures the call audio and streams it to a supported AI transcription 
service (AWS Transcribe, Deepgram, Google Speech, or OpenAI). The selected service returns 
transcription results continuously during the call, and PBXware forwards that text in real time 
to the configured WebSocket Callback endpoint.

To use Live Transcription, Stereo Recording must be enabled, and recording must be enabled 
on the selected ERG, Queue, or Extension, as the feature relies on stereo call audio for 
processing.

Live Transcription is enabled per destination:

•	 Enhanced Ring Groups (ERG): Navigate to Ring Groups → Enhanced Ring Groups and 
enable the new Live Transcription option under Record ERG Calls.

•	 Extensions : Navigate to Extensions → System , click Show Advanced Options, and 
enable Live Transcription under Recording.

•	 Queues (Contact Center only): Navigate to Queues, click Show Advanced Options, and 
enable Live Transcription under Recording.

PBXware supports provider-specific request settings (each service exposes a slightly different 
configuration). In this document we use Deepgram as an example, where options such as 
Interim Results, Smart Format, Keywords/Keyterms, Punctuation, Profanity Filter, Redaction, 
and others can be enabled per request, depending on the selected model and provider 
capabilities.
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WebSocket Callback (output)

The WebSocket Callback defines the destination where PBXware sends the real-time 
transcription output. This endpoint must be a customer-provided WebSocket server (custom-
built or hosted by the customer) that is reachable from PBXware and capable of receiving 
incoming transcription messages. PBXware uses the provided WebSocket URL to push 
transcription results in real time for live monitoring or further processing.

The optional Metadata field accepts JSON-formatted data that PBXware will include with 
every message sent to the WebSocket server. This is useful for correlating transcripts with call 
context (who called, which ERG/Queue was dialed, who answered, etc.). Metadata supports 
placeholders that will be populated automatically per call:

•	 %CALLER_ID% – Caller ID

•	 %CHANNEL_ID% – ID of the ERG/Queue that was called

•	 %CHANNEL_NAME% – Name of the ERG/Queue that was called

•	 %CALLEE_ID% – Extension that answered in the ERG/Queue

•	 %CALLEE_NAME% – Name of the extension that answered

Supported Live Transcription providers integrated in PBXware are AWS Transcribe, Deepgram, 
Google Speech, and OpenAI. PBXware supports Live Transcription through these providers 
and supports their currently available models at the time of release, while the available 
configuration options and model availability depend on the selected provider and may change 
over time. For more information about configuration steps and supported models, please 
refer to the official provider documentation.

Configuration

This option enables or disables Live Transcription for local calls.
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Text to speech
The Text to speech configuration has also been moved to the AI Hub section for easier 
management. It can now be configured much more easily, and per tenant. All it takes is 
toggling whether the feature should be enabled, and selecting a Provider from the dropdown 
menu of all available providers on the system/tenant.

Currently supported AI Provider for Text to Speech functionality is OpenAI.

Important Note: Since this has been moved to the AI Hub, it is a breaking change and will 
need to be reconfigured in case it was already set up prior to PBXware version 8.0.

Voicemail Transcription
Voicemail Transcription configuration settings have been moved to the AI Hub as well, while 
still functioning as before. This allows administrators to configure this feature per tenant, and 
manage it more easily. This way the service can easily be enabled/disabled, and the provider 
can be switched in a more simple manner.

Currently supported AI providers for this feature are Hosted Whisper, IBM, Google Speech 
and OpenAI.

Important Note: Since this has been moved to the AI Hub, it is a breaking change and will 
need to be reconfigured in case it was already set up prior to PBXware version 8.0.
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Stereo Recordings GUI configuration and resource 
usage
With PBXware 8.0, Stereo Recordings will be fully configurable through the GUI. On MT 
systems, if Stereo Call Recordings are enabled on the system, they will automatically be 
available on all tenants, otherwise they can be enabled on specific tenants. Enabling Stereo 
Recordings and choosing the Stereo Recording Format requires RAM disk to be enabled, 
and ‘Auto MP3 Convert’ to be set to either ‘Convert and keep original’ or ‘Convert and 
remove original’.

Stereo call recordings previously required significantly more temporary storage and memory 
since Asterisk simultaneously created three files per call: mixed (mono) file, left channel, 
right channel.

This resulted in nearly 3× higher RAM disk and IO usage, which caused issues in hosted 
environments with limited RAMFS capacity (e.g., 512 MB). This release introduces optimisations 
that significantly reduce RAM, disk, and I/O usage during active recordings while preserving 
audio quality and existing functionality.

With this release, the mixed (mono) file was removed. When stereo recording is enabled, the 
mono mixed file is no longer written, and only left and right channel files are recorded and 
stored. Since the mono file was always overwritten during post-processing anyway, removing 
it eliminates unnecessary writes.

Currently supported encodings are μ-law, WAV, and WAV16, with WAV as the default encoding. 
Stereo recordings do increase memory usage compared to mono sound files, but the increase 
is small (sub-3 MB). When the RAM disk is on; the audio quality does not change and it does 
reduce RSS growth.

Enabling stereo recording will increase system resource usage:

• Recordings will be stored as separate left and right channel files

• CPU usage may increase during recording processing
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Below is an example usage based on a 1-minute WAV recording:

The WAV encoding doubles storage compared to μ-law, with no intelligibility gain for voice, 
whereas WAV 16 quadruples storage and I/O load, yet still produces the same MP3 size. 
μ-law offers the best trade-off between: Storage efficiency, IO pressure, RAM usage and 
voice quality.

Custom address validation via middleware for 
Dispatchable Locations
In PBXware 8.0, We are introducing enhancements to PBXware’s emergency calling capabilities 
to help partners meet regulatory requirements (including the Ray Baum’s Act) and streamline 
dispatchable location management with Bandwidth and other SIP providers.  

New fields have been added to ‘Dispatchable Locations Setup’ to enable custom middleware 
apps for emergency calls. One of those new fields is ‘Address Validation Method’, where the 
administrator can choose either the standard USPS method or a custom method, which 
requires custom middleware to perform the validation.

Once the ‘Custom’ option is selected for validation, additional fields will appear to provide 
more options. ‘Custom Validation URL’ and ‘Custom Validation API Key’ will depend on your 
application, and will need to match the credentials for it. Additionally, Delivery Format can 
be picked between two options: ‘SIP Header’ and ‘PIDF-LO’.

Baseline (mono WAV) μ-law (ulaw) WAV (2 files) WAV16 (2 files)

RAM: ~0.93 MB
Storage: ~0.73 MB

RAM: ~0.90 MB (~-4%)
Storage: ~1.17 MB (~+60%)

RAM: ~1.8 MB (~+93%)
Storage: ~2.2 MB (~+200%)

RAM: ~3.8 MB (~+307%
Storage: ~4.1 MB (~+460%)
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Note: ‘Emergency Location Header will be used as the header name for sending locations 
when the chosen Delivery Format is ‘SIP Header’.

In an MT system, configuration can be made tenant-specific, but if nothing has been set 
tenant-wise, tenants will follow the system’s configuration.

The ‘Emergency Location Header’ field has been moved to the ‘Dispatchable Locations 
Setup’ section for easier configuration.

CRM Integration
PBXware v8 introduces a new, completely redesigned CRM Module, available in gloCOM 
Web and the new gloCOM Desktop application (v8). This new module is built on the CRM 
Connector (crmconnector) backend service and a unified gloCOM CRM Widget UI layer, 
providing improved flexibility, stability, and user experience.

Important: The legacy CRM integration module is not being replaced or removed. It will 
continue to function in PBXware v8 with the current (legacy) gloCOM Desktop application, 
ensuring full backward compatibility.

Key Improvements:

•	 Multiple CRM support per tenant/system – Supports multiple CRM integrations per 
tenant (Multi-Tenant edition) and per system (Contact Center and Business editions).

•	 Flexible authentication methods – Supports OAuth2, basic authentication, and 
provider-specific login methods.

•	 Permission Groups – Allows administrators to define per-integration permission 
groups that control which CRM data models (Account, Contact, Lead) each user can 
access, create, and edit.

•	 Configurable CRM data model – Full CRM configuration via PBXware → CRM → 
Integration Settings, including customizable record types (Contacts, Leads, Accounts) 
and configurable visible and required fields within gloCOM Web and Desktop 
applications.

•	 Unified CRM Widget – Enables automatic record matching based on phone number, 
email, or other supported matching criteria (depending on the CRM integration), manual 
search, record matching/rematching, creation of new CRM records, and adding subject 
and notes during calls and conversations.

•	 Automatic conversation logging (Voice & Messaging) – Logs only the final outcome of 
completed conversations, including call recording links, transcript links (where available), 
subject, and notes, across deskphone, desktop, web, and mobile devices.
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•	 Expanded CRM integrations – Built-in integrations include Salesforce, Zoho CRM, 
HubSpot, Microsoft Dynamics 365, Odoo (new), Pipedrive, SuiteCRM, Vtiger, Zendesk 
Sell, and SugarCRM, with enhanced Custom CRM Provider support.
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CRM Routing
CRM Routing introduces data-driven inbound call routing, allowing incoming calls to be 
automatically directed based on customer information stored in connected CRM systems. 
Instead of relying only on static IVR logic, routing decisions can now depend on real CRM 
data.

Administrators can configure flexible routing rules in PBXware that define what should happen 
when a recognized customer calls — for example, routing the call to a specific extension 
or account manager, forwarding it to an external number, playing an announcement, or 
ending the call. This enables smarter and more personalized call handling tailored to different 
customer types and scenarios.

CRM Routing is configured centrally in PBXware and works consistently across supported 
CRM integrations. A built-in preview and testing option is available, allowing administrators 
to validate routing logic and rule behavior before activating it in production.

Example: If a lead who is identified in the CRM as a CEO calls the company, the system 
can automatically route the call to their assigned account manager instead of sending them 
through the standard IVR flow.

For organizations using CRM platforms not natively supported by PBXware, Routing 
Integrations allows administrators to connect custom external APIs as data sources for 
CRM Routing. Each integration is configured with an endpoint URL, HTTP method, custom 
headers, and field mappings that define how incoming caller data is matched against the 
external system. 

When a call arrives, PBXware queries the configured endpoint in real time and uses the 
response to drive routing decisions. This makes CRM Routing extensible to any third-party 
CRM, customer database, or internal service that exposes an HTTP API.
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Contacts

Unified Contacts - Major Enhancement (v8)
Unified Contacts is now supported across all editions and fully replaces the legacy Central 
Phonebook. The new Contacts module introduces three structured contact visibility levels:

•	 Global – visible company-wide

•	 Department – visible only to selected departments

•	 Private – visible to the user who created the contact and to the system/tenant 
administrator

This structured visibility model enables more controlled and flexible contact management 
across the organization.

Centralized Contact Management (PBXware)
Within the Contacts module in PBXware, users can:

•	 Upload CSV files with different contact visibility levels (Global, Department, Private)

•	 Use smart CSV sync to prevent duplicates — existing contacts are updated and new 
contacts are added (contacts are not deleted during upload)

•	 Filter contacts by visibility level or source

•	 Manage contact information and visibility settings directly from the Contacts module

Uploading private contacts on extension level is now deprecated. Instead, private contacts 
are managed centrally within the Contacts module and can be assigned to extensions by 
administrators.

An additional Department Admin role has been introduced (enabled per extension), allowing 
users to manage contacts for all departments they belong to.
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Contact Center Enhancements (CRM Lite Capability)
For Contact Center users, contacts can include conversation history across channels. With 
permission-based access and cross-channel history, the Contacts module now provides 
a CRM Lite–style experience, enabling smaller Contact Center customers to benefit from 
structured customer context without requiring full CRM licensing.

Business edition users continue to have structured contact management without cross-
channel conversation history.

Deprecations & Compatibility Notes
•	 The legacy Central Phonebook is deprecated and replaced by the new Contacts 

module.

•	 Contacts management in OSC will continue to work, but with limited functionality 
(primarily private contacts only).

•	 For advanced contact permissions, structured visibility, merging, CSV smart sync, and 
cross-channel history, users must use gloCOM Web or the new Desktop application.

•	 Deskphone-only users may experience reduced contact editing functionality compared 
to previous behavior.
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CC Lite

Contact Center Lite Package
The new Contact Center Lite package is available across all editions, with primary licensing 
focus on Multi-Tenant and Business editions. The package introduces enhanced monitoring 
and reporting capabilities.

Contact Center Lite includes:

•	 Wallboard and additional dashboards for Enhanced Ring Groups (ERG)

•	 Scheduled Reports for ERG and Extensions statistics

•	 Enhanced Ring Group - Callback feature

Wallboard & ERG Dashboards
Wallboard and ERG dashboards are available in:

•	 gloCOM Web (v8)

•	 gloCOM Desktop / Electron (v8)

Company/tenant administrators can enable ERG dashboard access per extension, allowing 
users and managers to monitor specific or all ERGs.

Scheduled Reports (ERG and Extensions - v8)
Scheduled Reports for ERG and Extensions statistics are available across all editions.

Administrators can configure automatic email delivery of ERG or Extension statistics to 
selected stakeholders.

Reports can be customized by:

•	 Time period (hourly, monthly, yearly, or specific day(s))

•	 ERGs

•	 Members
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•	 Waiting time and talk time

•	 DIDs

•	 Customers

ERG Callback
With the release of PBXware v8, the Callback feature is available within Enhanced Ring 
Groups. Callback enables callers to hang up and receive a return call once a member becomes 
available, eliminating the need to wait in queue. Depending on the Enhanced Ring Group 
configuration, the feature can be triggered by a variety of scenarios, from caller-side events 
such as exiting via a dedicated digit or an abandoned call, to system-side conditions such as 
a full or empty ERG, among other configurable triggers. Each trigger can be independently 
enabled or disabled by the administrator.
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CONTACT CENTER MODULE

Voice Statistics - Depreciation Notice
With the release of PBXware v8, legacy Voice Statistics have been deprecated. All reporting 
functionality has been migrated to the new Statistics page, which now serves as the unified 
reporting engine for both voice and omnichannel data.

The new Statistics page introduces improved architecture, enhanced performance, and 
expanded reporting capabilities.

What’s New in Statistics (v8)
New and enhanced reports include:

•	 Queue Conversations per Disposition

•	 Voice Entry Positions

•	 Queue Callback Reports

•	 Agent Occupancy Report (Voice)

Reports now also support filtering by DID and Customer, making it easier to narrow down 
results across all available reports.

In addition to these new reports, new metrics have been implemented in alignment with 
industry standards, ensuring improved accuracy and consistency across statistics.

All reports now run on ClickHouse, providing significantly improved performance, scalability, 
and reliability compared to the legacy Voice Statistics engine.
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Important Notice
Legacy Voice Statistics will remain accessible for backward compatibility; however:

•	 They are officially deprecated

•	 They will no longer be maintained

•	 No new features or improvements will be added

We strongly recommend using the new Contact Center (CC) Statistics page to benefit from 
improved performance, enhanced metrics, omnichannel reporting capabilities, and future 
updates.

Contact Center Edition - Scheduled Reports Update
Scheduled Reports for Contact Center statistics (Agent, Queue, and Dialer reports) have 
been enhanced.

Reports can now be scheduled on:

•	 Hourly basis

•	 Monthly basis

•	 Yearly basis

•	 Specific day(s) basis

The previous daily and weekly scheduling options have been replaced with the more flexible 
“specific day(s)” option, allowing administrators to define exactly when reports should be 
sent.
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